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Introduction

Executive Insight increases the productivity of virtually every individual in an organization with faster, easier, and more
efficient communications. Executive Insight allows Microsoft Outlook users to manage all their communications from
within their email application. Users can instantly identify incoming calls, view all historical calls to and from their
phone, call contacts (including Microsoft Outlook contacts) quickly and easily, as well as check and process all their
messages. This guide provides step-by-step instructions on how to use the Executive Insight product.

Start Executive Insight

@ Note: Executive Insight does not automatically start when opening Outlook.

In Outlook, click the Connect icon.

2. The first time starting Executive Insight, you may be prompted to complete some initial setup using the Setup
Wizard.

3. Optional: Set up Executive Insight to automatically start when Outlook is opened.

a. From the Tools menu, select Phone.
b. Click the Load on Start option.

4. Executive Insight creates a folder in the Outlook mail folders named Phone. To return to the Executive Insight
view at any time, open the Phone folder (or click your extension icon).

. ______________________________________________________________________________________________________________________________________________________________|
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The Executive Insight Interface

[ Microsoft Outlook

! File Edit View Go

Your Extension
Tools  Actions ﬂeip

i B New ~ I.@ @ '—% Send/Receive ~ | [3f Search address books

Type a question for help |+

- @ .ai@ﬂad( @ @ 4| & @ outook:Phone

= X

=

i /2 Dial # Hang-up

% Hold [§ Park &3 Forward Al " Go Mobile - ¢ <In the Office>

: S snaglt [ | Window

]
Mail « |3 Phone - |
Favorite Folders 3 F = .

Py |2 calls | + Presence | 4 Conferences ' Chat Eunchis
LG Unread Mail @ Auckland P, 7|2 @t || Euid sh Fnea E |5 &
Eﬁ For Follow Up f) Akld Support _Ai 5 _And . -_B e = _C i i
[ Sent ttems £3 Melboume L =g fady e T andace
Mail Folders @ UK Shilt 2| @ & @ & *||2 B3 7|[PhE2 P
I
8] All Mail Items ;; ;IS|A Cathy P David W Ernie W Henk E Jason B Jason G
£ Sales - = = = =
= 4} Mailbox - Trevor Chen £ Sydney QJ & e Qhaa LI @lgu L Ql 8* het (Bl 2 @},EZ ‘5‘]
@ [ @Z_Personal A Personal Jason K John D John P Michelle C Miles v Rachel M
3 @ZE-mail - = = — =
(& Deleted ltems el & e | & & sh 2| 8« 2| 2| &g EIET
@ Drafts Ranee 5 Ruth E Sergio M Steve C Tom G
B Inbox
[ g Junk E-mail
Cutbox
il Phane Phone Fold
RS5 Feeds
E Sent Items
3 Spam
= 3 Search Folders
® 5 Archive Folders Presence Status
w
= CERE NN e || & nthe Office>  Schedule:On O Free Until: 5:30pm 2 <click to enter presence note> |

| &9 Ben Adams &9 Belle Peters

Gl Costonize Speed Toolbar

Done All folders are up to date, £3 Connected to Microsoft Exchange =

Toolbars

Show/Hide Toolbars
1. From the View menu, select Toolbars.

2. Click/clear the options to display/hide the toolbars.

Phone Toolbar

Toolbar options change dynamically based on current activity.

Icon Name Description

+ Answer Answers a call (only appears when a call is presenting).
o, Answer

7, Dial Dial Dials a contact.

2 Hang Up Hangs up a call (normally grayed out; this button is only

helicidls available when on a call).

27 Hold Hold/Unhold Holds/unholds a call. Hold music plays for the caller

¢ while on hold.

NEC Corporation of America ©2011 006NEC0307-00QRGR 2



The Executive Insight Interface Executive Insight Quick Reference Guide

Icon Name Description
@ Park Park/Unpark Parks/unparks a call. Hold music plays for the caller
e A while on park, but the line is free for you to make another
call.
7 Fudal Forward All Calls/Cancel Forward All Calls Forwards all calls/cancels the forwarding of all calls.
%2 Cancel Destination Cancel Cancels a transfer.
% &\_ Complete Complete Transfer Completes a transfer.

Speed Toolbar

Speed buttons for frequently used Phonebook contacts can be placed on a Speed toolbar to provide quick dialling
and a visual indication of an internal user’s Presence status.

i &9 Ben Adams &9 Belle Peters &9 Da\reJohnﬁgn &% Sally Clark L Customize i

Dave Johnston
Current Profile: <In the Office> - At my Desk

Add a Speed Button

1. Inthe Speed toolbar, click the Customize icon.
2. Select Add Speed Button.
3. Using the Phonebook, select the contact name and then click the Add button.

Make a Call Using the Speed Buttons

» Click the contact’s Speed button, and then click the contact’s phone number or extension.

Transfer a Call Using the Speed Buttons

» While on a call, click the Speed button of the contact to transfer the call to, and then select that contact’s phone
number or extension.

View a User’s Availability

» Hover the mouse over a contact’s Speed button to view the Presence status and ETR (if set).

&4 sally Clark

Sally Clark

Forwarded To: Mailbox
Current Profile: In a Meeting
Due back: 4:30 pm
Calendar: Conferencing

Request Availability Notification
»  Click the contact’s Speed button and then select either of the following:

= Notify Me when [Name] is Back when the extension is forwarded.
= Notify Me when [Name] is Off the Phone when the extension is busy.

A notification message displays when the contact is back/off the phone.

NEC Corporation of America ©2011 006NEC0307-00QRGR 3
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Voice Messaging Toolbar

Feature = Name Description
| <In the Offices . View or change the current active Presence profile.
GH Mailbox Setup Accesses the mailbox setup.

st Mailbox Either of the following:

= Click to automatically call voice messaging.
= View mailbox status:

— No messages.

— One or more ordinary messages.

SN

— The caller is currently recording a message.

— One or more urgent messages.

= %

@ Redirect Redirects an incoming call to voice messaging as a fax.

Phonebook Functions

Access the Phonebook

» Use any of the following methods to open the Phonebook:
=  Click the Phonebook icon.
<  Press Ctrl+P.
=  From the Call menu, select Phonebook.

Search for a Contact

1. Optional: To refine the search, select a specific search directory..

@ Global Directony w
@ Al Directories ~
w Perzonal Directaory

* Global Directary

2. Inthe Look for field, type the contact’s name.

NEC Corporation of America ©2011 006NEC0307-00QRGR 4
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B Phonebook D_<|
Look for | | in |‘ All Directories v|
Found contacts +o=E Numbers/&ddresses i i

@ Arton Francis - v & 4008

Y Belle Peters = (il +54 [9) 3551234

W Ben Adams @ +64 (2115472241

@ Bil Rogers ¥ [ belle@trainco.com

@ Eobby Zimmerman @ belle. peters

e Brian Jones 2 & belle. petersi@hotmail. com

e S —

53] B

Special Info/Mates

[ Select ] [ Call ] [ Lloze ] [ Help ]

3. Inthe Found Contacts section, select the contact’s name to display the associated contact numbers.

Add a New Contact

1. Click the Phonebook icon, and then select the directory that the new contact is to be in from the list of
directories.

In the Found Contacts section, click the Add a New Name (+) icon.
Enter the contact’s details, and then click OK.

In the Found Contacts section, select the new contact.

In the Numbers/Addresses section, click the Add a New Number icon.
From the Type menu, select the number type.

No ook obd

Enter the other required details, such as country code, area code, and number. The number must contain a
country code, area code, and the actual number; otherwise it cannot be dialled from Desktop.

@ Note: For New Zealand area codes, the leading 0 is not required.

8. Click OK.
9. To add additional contact numbers, repeat steps 5 though 8.

Edit Contact Details

1. Click the Phonebook icon, and then either:
=  Select either the contact name or number, and then click the Configure this Name/Number icon.

= Right-click either the contact name or number, and then select Properties.
2. Update the contact’s information, and then click OK.

Delete a Contact

1. Click the Phonebook icon, and then either:
= Select either the contact name or number, and then click the Delete this Name/Number (=) icon.
= Right-click either the contact name or number, and then select Delete.

2. When prompted to confirm the deletion, click Yes.

NEC Corporation of America ©2011 006NEC0307-00QRGR 5
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Presence

Presence buttons provide real-time visual information on the whereabouts and availability of staff. If an employee is
out of the office or in a meeting, the system displays the Due Back time. When an employee is away from the desk or
on a call, you can request an automatic notification alert for when the employee is available. Use the Presence
buttons to call staff. Presence buttons can be grouped and arranged on separate pages.

B Channel Team | @ US: Office |43 Support Team | 49 N2 Oifice | 23 UK. Office | 4B MEL: Office | 43 vD: Olfice|
Bed 7@ & 7| & w|@ & #|(@ & 7B & P||Eex B Brid ¥|B & '#|[GP& w| 2
Aimee 2 Andrew F Anthony G Easmarn H Beverly B Bill C Brady Brady C1 Brian H Bryan M Bryce F
B8 »|[Bpi2 #|[@ & 7|[BrE& ¥#|B Bhrx t2|[B] & B|BrE t2|(Brx ¥\ B & ¥[8 & ¥
Cathy P Christian & Christopher M Chuck © Conference R Dan H Diavid C Dravid W Dorian 5 EdC Ernily H
B || @ & 7| 2 & 7|4 & *7|[® = Bisil h|[Ep8 @ & ¥
Ernie ‘W Escalations ¢ Evan K GDRH Henk E Hoang IMNUCE45100 O Jarnes B Jason G Jason K Jirn i
B & ¥|[prii #|Bril H|[E & | [BrE F|ERE v|Brw Y|[B & Y|E & Y|[BrFE ¥ &
Joe O John John P Johnna E Jon C J0sh B2 - L1 J0eh Lindebadt on 6206 Liliana &
(=2 & B8 o o _@?_IIDEQ ] g"& ¥ g’:}?agdm =] £ |5 Forwarded to Malbox
Mandana M| | Marketing g Michelle C Mike D Miles v Hew & _| 1% Current Profile; Out of Office
- — — — = 5 Due back: 371872011 &:00 am [GMT+4] (31182011 5:00 am)
ki 2|[d & 2|[2] & 'w|(o#ER h|[2eE2 Sh|[Dew Urknown -
Sergio M Steve C Sylvia R Tim W Tom F TomG || TomasL ||UCE Backline Q |[USA Frontine Q || USA SEHD G William
[a@ 2 (Wil =T 1 ()

Presence Buttons

The following are two types of Presence buttons:

0

External = Telephone numbers outside the office.

Tarn F James B ‘

Internal = Extension numbers in the office. Use the Internal Presence buttons to:
View the user’s extension status by viewing the icons and the status tooltip.

Perform advanced call functions for an extension by right-clicking the icon. A user’s
name displays in yellow text if logged into queues as an agent.

B & %PHQPEB &

Darian 5 Wayne M

Presence Icons

Ilcon Description

Phone Call Types

(Gray) Extension is idle.

(Various colors) Extension is ringing or offering.

(Various colors) Extension is busy (on the phone).

Extension is forwarded to another number (internal or external).

Forwarded to voicemail.

(Green) Inbound non-queue call.

EL@?LL%

(Pink) Outbound non-queue call.

(Yellow) Inbound queue call (if queuing is installed).

(Blue) Outbound queue call (if queuing is installed).

|

NEC Corporation of America ©2011 006NEC0307-00QRGR
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Icon Description

Profiles

a In the office.

i3 In a meeting.

e Out of the office.

= On vacation.

a (Gray Head) Agent is logged into the queues.

Voicemail Status

gg] No messages.

.551 One or more standard messages.

!P One or more urgent messages.

Additional Functions Using the Presence Buttons

Display Additional Contact Numbers

1. In the Active Calls window, click the Phone Status icon to display additional contact numbers.

il +54 (9) 3551234
B +64(21) 5472241
] belle@trainco. com

2. From the menu, select the number to call.

. ______________________________________________________________________________________________________________________________________________________________|
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Right-Click a Presence Button for Additional Menu Actions

» Right-click a Presence button, and then select the preferred action from the menu.

Note: The actual options available depend on the type of PBX being used, how the system is set up,
and the enabled security permissions. Certain options are also only visible when there is an active call

on the extension.

%~ supervised Transfer to Jo Cousins on 76003

| %~ Blind TransFer ko Jo Cousins on 78003
E Park for Jo Cousins

: E Advanced Park. ..

| %7 Matify me when Jo Cousins is back
-?E"i» Forward all Calls,..
B Transfer to Mailbox
=] Recard inta this Mailbox

Select Presence Profile

Renarme
Delete

Icon Name

Description

F Call User on Extension

Initiates a call to the user on the designated telephone number.

Supervised Transfer to User

2 Blind Transfer to User
Transfer Call

Transfers the Active Call to the user’s extension, and talk to the user
before completing the transfer.

Transfers the active call to the user’s extension.
Transfers the active call to the user’s extension.

Park for User

Advanced Park

Holds the active call at the user’s extension; the user can then retrieve
the call.

Parks the active call and pages the user.

Notify Me when User is Back

A ScreenPop informs when the user is in the office and available to
take the call.

& Forward All Calls

Forwards all calls to a specified internal or external number.

Leave a Voice Message
5 Transfer to Mailbox

Record a voice message for the recipient.
Transfers the active call to the user’s voicemail.

Ask User to Call Me Back

The user receives a ScreenPop callback request upon return.

&
= Record Conversation to
Mailbox

The conversation saves to the current user’s mailbox (if installed).

Send Message to Digital Phone

Sends a short text message to the LCD screen of the user’s digital
phone.

Select Presence Profile

Changes the user’s Presence profile.

Rename Renames the Presence button.
Delete Deletes the Presence button.
View As Changes the Presence buttons’ appearance.

NEC Corporation of America ©2011
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Set Presence Profile

»> Use either of the following methods to select a preferred profile:

= The Presence list.
= Right-click a Presence button, and then select Select Presence Profile.

Presence: & <In the Office> R
B3 n 2 Mesting

>

2, _<In the Office>

% On Vacation
Out of Office

B2 | eave Voice Message
@ Forward all Calls...

4 £2 1In a Mesting
£ <n the Office>
Delete P On vacation
Contact Properties. .. n Out of Office
View @s... L4

Scheduled

Set an Estimated Time of Return (ETR)

An Estimated Time of Return (ETR) can be set for the Presence profiles used when you are not available.

1. Select a profile, and then click the calendar function.

Presence Profile: Out of Office

Please specify the approximate date and time of your retum

Expected Time of Retum

110 minutes

20 minutes July 2003
el Mon Tue Wed Thu Fi Sat Sun
thox T2 3 4 5
2 hours

Tomomow 6 7 8B 9 10 11 12
Monday next week 5 16 17 18 19

A 21 2 23 4 %5 %
27 28 ¥ W AN

[ Today: 14/07/2009

3:4856pm. [§

[ sperR | ok J[ cencel |[ Heb

2. Select the date of return.

Note: Unless the ETR is set as mandatory in the system settings, an ETR can be skipped by clicking the
Skip ETR button.

3. Select the approximate time of return using the standard times in the left window, or by setting the time using the
clock field’s up and down arrows.

4. Click OK to save the ETR and activate the selected Presence Profile.

NEC Corporation of America ©2011 006NEC0307-00QRGR 9
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Presence Status

Your Presence status is indicated in the Status Bar. The status information can be viewed by other users via your
Presence button or from the Phonebook.

s <inthe Office>  Schedule:On 9 Free Until: 12:00pm & This is an example of a note

B & *

Trevor C

Call Trevor Chen on

E Current Profile: <In the Office= - At my Desk
# This is an example of a note
5 Free Until: 12:00 pm

Add a Presence Note

This section describes how to add a personal Presence note to your Status Bar with additional information about
activities and availability to coworkers.
1. In the Status Bar, click the Presence note text <type Presence note here>.

2. Type the information, and then press Enter. This Presence note remains until it is cleared or a new note is
created.

Add a New Presence Page
Use the Add Presence Page wizard to create either Standard or Dynamic Presence pages:

= Dynamic = Automatically lists the contacts for a company or department.
< Standard = Manually add and arrange the contacts.

@ Note: Only users with System Administrator rights can add or edit Global Presence pages.

1. Use either of the following methods to start the Add Presence Page wizard:
=  From the File menu, select Add a New Presence Page.

= Right-click in the Presence window, and then select Add a New Presence Page.
2. Click Create Personal Presence Page (only administrators can create global pages), and then click Next.

3. Select the type of page to be created. Click either:
= Standard Page to manually add and arrange Presence buttons. If chosen, proceed to the next step.
= Automatic Page = Automatically adds and updates Presence buttons for the selected company/
department. If chosen, complete the following substeps.
a. Select a company from the listed companies, and then click Next.
b. Optional: Select List Only Contacts for the Selected Departments, and then click Next.

@ Note: This step only displays if departments have been defined.

c. Click the department(s) to display if the department option was selected in the previous step, and then
click Next.

d. Optional: Click the Create Additional Pages option, enter the number of buttons per page, and then
click Next.This option defines a maximum number of Presence buttons per page and automatically
creates an additional page when this maximum is reached.

4. Type a name for the Presence page, and then click Next.
5. Verify the settings and click Finish to create the Presence Page.

I ——
NEC Corporation of America ©2011 006NEC0307-00QRGR 10
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Rename a Presence Page

1. Use either of the following methods to rename a Presence page:
=  From the File menu, select Rename this Page.

= Right-click in the Presence page, and then select Rename this Page.
2. Type the new name for the page, and then click OK.

Delete a Presence Page

1. Open the page to delete.
2. Right-click in any blank area, and then select Delete this Page.
3.  When prompted to confirm the deletion, click Yes.

Add a Presence Button

1. Right-click in the Presence page, and then select Add a Presence Button.
2. Select either the contact name or the contact number (or drag a contact name or number from the Phonebook to

the Presence page), and then click OK.
Delete a Presence Button

» Right-click a Presence button, and then select Delete.

| % Messages |

Messages: |£ Bella Stuart v|@

From/Tao Mumber Date/Time &

€ Mailbox Settings for Bella Stuart [#9844]
General | Presence Profiles | Caller Prafiles | Distribution Lists |

i Frafile Fonaard
£0  <nthe Officer No
231 In a Meeting tailbos

Mailbox
Mailbox
Mailbox
No

Mailbox

*/5  0OnSid X Delete

! ¥ Activate

NEC Corporation of America ©2011 006NEC0307-00QRGR 11
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Call Functions

Make a Call

» Use any of the following methods to make a call:
= Use the Phonebook:
1. Click the Dial icon.
2. Click the Phonebook icon, and then select the preferred contact name/number.

3. Click the Call button, and then press Enter.
= Use the Presence button by either clicking the:

—  Preferred contact’s Presence button to call the contact’s default number.
— Phone Status icon on the contact’s Presence button, and then click the preferred number.
= Click a contact’s Speed button on the Speed toolbar, and then select one of the contact’s numbers.

Answer a Call

> In either the Phone toolbar or Phone Calls window, click the Answer icon.

[@ s9635 |

4 Hengup 27 Hold [ Pak % Transfer (=) Record
© Direct Call Duation: - 0:03
89585

Active Call Icons in the Phone Calls Window

Icon Description

4: Hangup Hangs up the active call.

2 Hold Places the active call on hold.
(@ Park Parks the active call.

&~ Transfer Either:

= Transfers the active call to the entered transfer destination number.
= Used to conference a third-party into a call.

& J Complete Transfer Completes the transfer (or hang up the phone).

%7 Cancel Cancels the transfer.
{Z Swap Swaps the calls (e.g., connects to the original caller or the transfer destination).
(= Record Records the conversation from the active call.

NEC Corporation of America ©2011 006NEC0307-00QRGR 12
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Transfer a Call Using the Phonebook

While on an active call, click the Dial icon and then the Phonebook icon to open the phonebook.
In the Found Contacts section, select the contact to transfer the call to.

In the Numbers/Addresses section, select the contact’s number to transfer the caller to.

Click the Transfer button.

o Nd

@ Note: To assist the transfer, stay on the line until the party has picked up (otherwise complete the call
right away).

Voice Message Functions

Play a Voice Message

1. In the Calls window, either:
= Double-click the voice message.

= Right-click the voice message, and then select Play Message.

93637 S 11.(5949) 2651030
2 BIEIT Call this Number 64 19) 3095943

2 89637 Add to Personal Phonebook. .. 54 [9] 2633333
Add to Global Phonebook... l

_ Associate with Existing Contact. .. |_
|

BIE3T Idle | Mark as Unread
X fnswer & Mark as Saved

Play Message...
R~ l..-.-l—:-..-| e e

2. Click either the Phone or Speaker icon.
3. Click the Play icon.

4. At any time while the message is playing, click the:
= Stop icon to stop the playback.

= Volume slider to adjust the volume.

= Rewind icon to rewind the message.

= Pause icon to pause the message.

= Fast Forward icon to fast forward the message.

5. To save the message as a .wav file on the PC, click the Save icon. Play the file using the Windows Media Player
or another compatible multimedia program.
Forward a Voice Message

Use the Forward Message feature to forward the voice message to a mailbox user or a distribution list.

@ Note: If the Keep a Copy option is not chosen, the message deletes from the mailbox.

Delete a Voice Message

Use the Delete Message option to delete a voice message.

NEC Corporation of America ©2011 006NEC0307-00QRGR 13
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Executive Insight Quick Reference Guide

Desk-to-Desk Chat

Use Desk-to-Desk chat to have a conversation in real time with other internal users by typing text.

» Click the Chat tab to open the Chat window.

Chat Record Current Chat
Tree Session

G) ChalMEssagEsl @ Dliver Stanley

[ chat |

¢ End Conversation ",Transfer &/ Invite. | °F fulall} H Save Conversation '

Chat Toolbar

8 Oliver Stanley
£ Trevor Chen
.

Chat Parties I

Hi

Oliver Stanley

Thank you for the information you gave me yesterday.

Trevor Chen
Pleasure. Hope it helped

11:27 am

11:29 am

Thanks Dialogue and
Oliver Stanley MESSEQE Entry 11:30 am
all good
32 5end Text
B oom
il | & Inthe Office 3 Schedule: On 8 Free Until: 5:30pm 4 <click tn enter presence nate>

Chat Buttons

Button

Description

“J Initiate Chat...

Starts a new chat call to either a selected chat user or chat queue.

f; End Cornverzation

Ends the current chat call.

& Transfer.. Transfers the current chat call to either a selected chat user or chat queue.
B i Invites one or more chat users to join the current chat call. Invitees must accept the invite to join.
B3 Copy Select the chat window, and then click the Copy button to copy the chat window to the clipboard.

H Save Conversation

Saves a transcript of the chat conversation in a text format to a specified disk directory.

25)5end Text

Transmits the typed text. Alternatively, press the Enter key.

ﬂ Close

Closes the current chat window.

1:,—) Chat Templates. .

Adds, edits, or deletes standard chat phrases or commonly used URL links

-

A list of saved text phrase. When selected, the phrase is sent directly to the other chat parties.

w o,

A list of saved URLs. When selected, the URL is sent as a link directly to the other chat parties.

&} Send Curent URL

Pushes the current Desktop browser URL to the chat recipients.

@ Trace URL

Automatically sends a series of web page URLs while navigating using the Desktop web
browser—toggles this feature on and off.

NEC Corporation of America ©2011
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Button Description
& Trevor Chen Chat conversation—when pink, an outbound chat conversation.
@ Trevor Chen Chat conversation—when green, an inbound chat conversation.

Make a Chat Call

Click Initiate Chat to start a new chat call.
Click either Chat User or Chat Queue, and then select the specific entry from the list.
Click the Chat button in the window, and a new conversation window opens.

In the message text field, type the message and then click Send Text (or press the Enter key) to transmit the
typed text. An outbound chat call shows as waiting in the Active Calls window until the recipient answers the call.

H> o~

End a Chat Call

1. Click End Conversation.

2. Optionally, click Save Conversation to save a transcript of the chat conversation in a text format to a specified
disk directory.

3. Click the Close button to close the conversation window.

Answer a Chat Call

1. When a new chat call message displays, either click:
= Accept to answer the chat call, and then navigate to the Chat window by clicking the Chat tab.

= Show Call to display the Chat window, and then click Accept.

2. Inthe message text field, type the reply message and then click Send Text (or press the Enter key) to transmit
the typed text.

Transfer a Chat Call

Click Transfer to transfer the current chat call.
2. From the list, select a chat user or queue.

3. Optionally, click the Include Current Chat Conversation option to give the recipient access to the prior
dialogue.

4. Click Transfer to complete the call transfer.

Invite Additional Chat Participants

Click the Invite icon.
Select one or more chat users to join the current chat call.
Optional: Click the Include Current Chat Conversation option to give the invitees access to the prior dialogue.

P owNd

Click the Invite icon to send the invitations. Invitees must accept the invite to join.

. ______________________________________________________________________________________________________________________________________________________________|
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Private Chat

When there are three or more chat participants, you can have a private chat with a selected participant.

1. Right-click the participant’s name.

£ Trevor Chen

£ Trevar Callin

./ Paul Enin [invited)
g ]

™ Private Chat to Alex Wilson
‘.v Mudge Alex Wilson...

‘,—- Mudge with Text...
| &l Contact Properties...

2. From the menu, select Private Chat to [name]. A new chat window opens to enable the private chat session.

Chat Messages

The Chat Messages feature provides an organized listing of chat conversations and chat users. Select the required
category and then use the right-click menu to access the available functions for the selected chat session or user.

F1 Help: For more details on Chat Messages and additional functions and configuration settings, refer to the
online help.

) Chat |
S
i ChatMessagesfl
= = i
%) intisteChet.. | T Chat Templates.. | 22
=5 Chat Show messages from: Yesterday | 7 days | 30 days | &l available
ull v Crials Participants Datei T\me] Type Dulalion] Queue
t Histary
B e e Stem Y/0E/2070  S5006 am. Outbound 259
“i|Lee Stemn 9/06/2000 11:2342 4. Answered 218
2| Oliver Stanley 9/06/2010  11:27:58 a...  Answered 242

Create and Use Templates

Use the Desktop Agent templates to save and use commonly-used phrases and URLs when chatting.

Create Template

1. Click the Chat Templates icon.
2. Click either the Phrases or Links tab in the Templates window. The existing entries that display can be edited or

deleted.
3. Click Add and enter a suitable label and the associated text or URL.
4. Click OK.

Use Template

1. Click the down arrow for either of the following icons:
= Chat Templates

= URL
2. Select the required item from the menu.

The text phrase is automatically sent to the other chat parties. The URL is pushed to the other chat parties.

@ Note: When a URL is received in:

= Desktop, the URL shows as an active link and the built-in Web Browser automatically opens the
web page.

= Executive Insight, the URL shows as an active link.
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Additional Chat Functions

» Refer to the online help for additional less-frequently used functions and configuration settings.

Configure the Add-in Options

Use Outlook’s CTI Add-in function to configure Executive Insight and set user preferences.

@ Note: Refer to the online help and the User Mailbox Setup Quick Reference Guide for more details.

» From the File menu, select CTI Add-in.

Executive Insight Quick Reference Guide

G Microsoft Qutlook l_l_lg: C]
m Home  Send/Receive  Folder  View  AddIns o @
2 A
E s
i - |Zeacom CTI Add-in Options
- ﬂ Executive Insight is connected. Q
Info
Enabled Services Om"
Executive Insight (requires Outlook restart) ( zeac
Open i i communications center
Print Zeacom Communications Center
This product contains Executive Insight and other modules and applications that are part of
| CTAdd-in i E Options Zeacom's Unified Communications suite.
Load On Start & 6
Help Show Speed Toalbar 0 About Executive Insight
Version: 5.1.0.500
|23 options 2010 Zeacom Limited. All rights reserved.

B exit 5

Executive Insight
Preferences

Voice Messaging
Settings

Executive Insight Telephony Preferences

Select your preferences for the way you would like your integrated

telephony functions to operate inside Outlook.
In this section...

- General Options

- Display Options

- Screenpop Options
- Outlock Contacts
- Timers

9

Zeacom Software License Terms

Executive Insight Voice Messaging Settings

Select your settings for the way you would like your integrated voice

messaging functions to operate.
In this section...

- General Settings
- Presence Profile

- Caller Profiles

- Distribution Lists

- Schedule

- One-Touch Keys

- Email/Calendar Integration
- Notification

- Advanced Settings

9

Item Description

The CTI Add-in menu option.

Set the required start-up options.

Set up or edit personal mailbox settings, including recorded Presence profile greetings and the mailbox

schedule. The first-time start up wizard initially assists in configuring the essential settings.

View Executive Insight’s version details.

o Set up user-defined preferences for Executive Insight. When set, these usually do not need to be changed
again.

NEC Corporation of America ©2011
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Empowered by Innovation

Corporate Headquarters (Japan) Oceania (Australia) North America (USA) Asia Europe (EMEA)
NEC Corporation NEC Australia Pty Ltd. NEC Corporation of America NEC Corporation NEC Unified Solutions
www.nec.com www.nec.com.au www.necam.com www.nec.com www.nec-unified.com

About NEC Corporation of America: Headquartered in Irving, Texas, NEC Corporation of America is a leading provider of innovative IT, network, and communications products and solutions for service carriers,
and Fortune 1000 and SMB businesses across multiple vertical industries, including Healthcare, Government, Education, and Hospitality. NEC Corporation of America delivers one of the industry's broadest
portfolios of technology solutions and professional services, including unified communications, wireless, voice and data, managed services, server and storage infrastructure, optical network systems, microwave
radio communications, and biometric security. NEC Corporation of America is a wholly-owned subsidiary of NEC Corporation, a global technology leader with operations in 30 countries and more than $38.5
billion in revenues. For more information, please visit www.necam.com.

© 2011 NEC Corporation. All rights reserved. NEC, the NEC logo, and UNIVERGE are trademarks or registered trademarks of NEC Corporation that may be registered in Japan and other jurisdictions. All

trademarks identified with ® or ™ are registered trademarks or trademarks respectively. Models may vary for each country. Please refer to your local NEC representatives for further details.
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